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Introduction 

 
 
 
 

About this manual 
 
This manual is for users who plan to capture x-ray images from film in 
digital form using a VIDAR film digitizer and the VIDAR TWAIN 
software interface. 
 
The manual explains how to use VIDAR film digitizers with 
commercially available TWAIN-compliant applications for Windows 
2000 or Windows XP. 
 
The VIDAR TWAIN software interface is compatible with these VIDAR 
film digitizers: 
 
� DiagnosticPRO Advantage, DosimetryPRO Advantage and CadPRO 

Advantage 
 
� DiagnosticPRO™ and DiagnosticPRO plus™. 
 
� SIERRA™ and SIERRA plus™. 
 
� VXR-16™ and VXR-16 DosimetryPRO™. 
 
� MammographyPRO™. 
 
� VXR-12 plus™. 
 
� VXR-8 plus™. 
 
� TeleRadPRO™. 
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Conventions used in this manual 
 
� Special keys you press on the keyboard appear in small capitals.  For 

example, ENTER and TAB. 
 
� File and directory names appear in italic.  For example,  

\My Documents\Notes.txt. 
 
� Menu names and menu commands appear in Block Letters.  For 

example, File > Open...  . 
 
� Windows, buttons, dialog boxes and other on-screen features are 

named in Bold type.  For example, the Save button. 
 
� Hyperlinks are underlined.  If you are viewing this document 

electronically, click a hyperlink to view related material. 
 
 
 

Skills required 
 
You should have experience using computer applications running under 
Windows 2000 or Windows XP.  Experience with film digitizers and 
imaging software is also helpful. 
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Customer support 
 

Note:  For customer support questions, VIDAR recommends 
that you first contact the system integrator that supplied your 
system, since the integrator is more familiar with the specific 
system setup than VIDAR personnel. 

 
 
Before calling or e-mailing VIDAR, be sure you have the following 
information: 
 
� Customer name and contact information, including telephone number 

and e-mail address 
� Software name and version 
� Scanner serial number 
 
 
 
Contacting VIDAR 
 
Technical support for film digitizers is available from VIDAR Monday 
through Friday from 8:00 am to 12:00 pm, and 1:00 pm to 5:00 pm 
Eastern Time. 
 
� By e-mail:  medtech@vidar.com. 
 
� By telephone:  call 800-471-7226 (in the U.S. only) or 703-471-7070 

and ask for Medtech. 
 
Technical and sales information is also available on the web at 
www.filmdigitizer.com. 
 
 
 

More information about digitizers 
 
For more information about VIDAR film digitizers, refer to your film 
digitizer’s installation guide, or visit www.filmdigitizer.com. 
 

mailto:medtech@vidar.com
http://www.filmdigitizer.com/
http://www.filmdigitizer.com/
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Getting started 

 
 
 
 
For instructions on setting up and using your VIDAR film digitizer, 
please refer to the film digitizer installation guide. 
 
 
 

System requirements 
 

You must supply a computer system that meets or exceeds the following 
requirements: 
� 600 MHz  
� 512 megabytes (MB) of random access memory (RAM) 
 

Note:  Scanning 14" x 17" (or larger) films at high resolution and 
bit depth produces very large files, which must fit into system 
memory.  If installed memory is not sufficient, software and/or 
system crashes may occur. 

 
� Windows 2000 (Service Pack 4 or higher) or Windows XP 

Professional Edition (Service Pack 1 or higher). 
� SVGA monitor 
� Display card with 8 MB of video RAM 
� CD-ROM drive 
� VIDAR-supported Adaptec® 2930 Ultra PCI SCSI adapter  
� TWAIN-compliant host application.  VIDAR TWAIN has been 

tested with Jasc PaintShop Pro and Adobe Photoshop imaging 
applications.  
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Important Information 
VIDAR’s TWAIN is not fully compliant to the TWAIN standard, 
and is therefore supported only as a baselining test tool for use 
with the aforementioned applications. VIDAR does not provide 
support for new third party software integrations using the 
TWAIN. VIDAR has an Active X Toolkit available for developers 
who wish to integrate software for use with its film digitizers.  
 
Due to the lack of display look-up tables (LUTs) in graphical 
imaging applications, acquired images may appear too light, 
and may require minor gamma corrections to make them look 
like the film.  For further instructions, see “Appendix: Improving 
image quality.” 

 
 

 
Turning on the VIDAR film digitizer 

 
Always turn on the VIDAR film digitizer before turning on the computer 
(this allows the computer to recognize the film digitizer).  Refer to the 
hardware manual for the location of the film digitizer’s power switch. 
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Installing the VIDAR TWAIN software 
 
 

Note:  This version of TWAIN will not work with Windows 2000 
or Windows XP systems with ASPI drivers installed.  If you are 
using either of those operating systems, you must install 
VIDAR’s STI drivers before using TWAIN.  See Appendix: 
VIDAR device drivers. 

 
You may obtain the TWAIN 5.2 from Vidar’s technical support 
(medtech@vidar.com) or via Vidar’s web page, www.filmdigitizer.com/. 
Please note that the TWAIN-compliant host application m ust be intalled 
before installing the TWAIN. 
 
�  To install the TWAIN: 
 

1. Double-click on twain5-2.exe. 
 

2. The InstallShield Wizard will launch. 
 

3. Click Next in the Welcome window. 
 

4. Click Yes to accept the License Agreement. 
 

5. Click Next in the Driver Information window after confirming 
that the system is using the correct driver setup. 

 
6. Wait a few seconds while files are installed. 

 
7. Click Finish when you see the InstallShield Wizard Complete 

message. 
 
 
 

mailto:medtech@vidar.com
http://www.filmdigitizer.com/
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Accessing the VIDAR TWAIN interface 
 
Applications such as PaintShop Pro and Photoshop use the TWAIN 
software to enable communications between the application and the film 
digitizer. 
 
� To access the TWAIN interface: 
 

1. Launch the host application. 
 
2. In the host application, select the VIDAR TWAIN interface. 
 
3. Use the host application’s import or acquire function to access the 

TWAIN scanning interface.  The method for doing this depends on 
the host application (refer to the host application software manual 
for instructions on selecting and opening TWAIN scanning 
interfaces).  In Photoshop, for example, use the File > Import > 
TWAIN_32 command to open the Select Source window: 

 

  
 

Note:  In most TWAIN-compliant host applications, you must 
select the appropriate TWAIN interface before you can import 
from a peripheral device.  If you have just one TWAIN interface 
installed, you only need to select it once—before its first use.  If 
you have multiple TWAIN interfaces, you must select the 
desired TWAIN). 

 
 
 

TWAIN 4.2 user’s guide 
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If the digitizer is performing it’s warming up sequence when you launch 
the TWAIN, you will see the following message: 
 

 
 
It is strongly recommended that you allow the digitizer to completely 
warm up, otherwise image quality will be compromised.  If the Scanner 
Is Warming Up! window appears: 
 
� If you don’t click either button:  The TWAIN interface will appear 

when the digitizer completes its warm-up cycle.  This is the preferred 
technique. 

 
� To abort the TWAIN software and return to the host application:  

Click Abort. 
 
� To proceed before the digitizer is warmed up (this may degrade image 

quality):  Click Ignore. 
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The first time you launch the TWAIN software, a message about film 
orientation will appear (see below).  Read the message, then click OK. 
 

 
 
 
When using the TWAIN software: 
 
� When scanning to disk, use lightbox loading, as specified in the 

message above. 
 
� When Multi-Film Mode or Save To Disk are deactivated, you will 

be required to load films differently to produce an image in the proper 
orientation: 
1. Hold the film in front of you, as you would view it on a lightbox. 
2. Turn the film end over end, then place it in the scanner. 

 
Note:  Additional details about film loading are in the “Scanning 
films” chapter. 
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Main window 
 

 
 
 
After setting up the VIDAR film digitizer, connecting it to your 
computer, and installing the TWAIN software, you may begin digitizing 
films.  This chapter explains each of the controls in the Main window. 
 
Options in the Main window (shown below) of the VIDAR TWAIN 
software control the film digitizer’s basic scan parameters. 
 

 

This space is the Preview 
area, where images will 
appear when a PreScan 
is performed. 
 
When the Scan 
command is used, 
images will appear in the 
host application. 

TWAIN 4.2 user’s guide 
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When the TWAIN software is installed, Multi-Film Mode and Save To 
Disk will be activated by default if the film digitizer is a multi-film model. 
To change the Save To Disk option, first deactivate Multi-Film Mode. 

 
 

Note:  TWAIN 5.2 supports single film scans to memory, but 
multi-film or batch scans can only be saved to disk. This means 
the images will not appear in the host application—they will be 
saved to the chosen location on the hard disk. Third party 
medical imaging application vendors cannot support scanning 
multiple films to the screen (memory) with the VIDAR TWAIN 
interface.  For images to appear in the host application, the 
TWAIN interface must be in Single Film Mode (i.e., Multi-Film 
Mode deactivated) and Save To Disk must be deactivated. 
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Image Properties 
 

 
 
The Image Properties section in the Main window contains options for 
the resolution, depth and number of films for scanning. 
 
 
 
Resolution 
 
Resolution determines the amount of detail captured in the film.  
Scanning at a higher resolution captures finer detail than scanning at a 
lower resolution.  However, a lower resolution image has a smaller file 
size and requires less memory.  Select a resolution value based on the 
display capabilities of your computer monitor, the amount of available 
disk storage space, the transmission time requirements, and the need for 
fine detail. 
 
The Resolution list allows you to select one of the resolutions supported 
by the film digitizer.  The list shows resolutions in dots per inch (dpi).  
The resolutions available depend on the digitizer model you are using. 
 
� To set resolution:  Open the Resolution list and click the desired 

resolution. 
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Depth 
 
Depth refers to the number of data bits the film digitizer captures per 
pixel.  It determines the maximum number of grayscale levels the film 
digitizer can distinguish in an image.  Use the Depth list to select the 
number of data bits saved for each pixel in a scan.  The depths available 
depend on the digitizer model you are using. 
 
� To set depth:  Open the Depth list and click the desired depth. 
 
 
 
Number of films 
 
The Num. Films list allows you to select the number of films you want 
to scan when in multi-film mode.  Note that this option is grayed out if: 
� You are using a TeleRad PRO™, VXR-12 plus™, VXR-8™, 

SIERRA™ or SIERRA plus™ with single-sheet feeder; or, 
� You have not activated Multi-Film Mode in the Main window. 
 
� To set the number of films:  Open the Num. Films list by clicking on 

the down arrow and click the desired number. 
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Scan Size 
 

 
 
The Scan Size section of the Main window allows you to define the 
length and width of the film to be scanned. 
 
� To set film length and width: 
 
 Enter values in the Width and Length boxes. 
  or 
 Click Scan Size to select from a list of standard film sizes (see next 

page). 
 
The Units menu (in the Advanced Options window) determines the unit 
of measure (inches, centimeters or pixels) for the Width and Length 
boxes. 
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Scan Size 
 
If you are digitizing a standard film size, you may select the size from a 
list of standard film sizes available in the Scan Size window.  Auto Size 
must be deactivated for the Scan Size button to be available. 
 
� To select a standard film size: 
 

1. Click the Scan Size button in the Main window.  This opens the 
Scan Size window: 

 

  
 
2. Click the appropriate film size in the list. 
 
3. Click OK.  The Scan Size window closes, and the selected size 

appears in the Width and Length boxes. 
 
 
� To add a custom scan size to the list:  Enter the new size in the 

Selected Film Size box, then click Add. 
 
 
� To modify an existing size in the list:  Click the desired size, edit the 

values in the Selected Film Size box, then click Modify. 
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� To remove a size from the list:  Click the size, then click Delete. 
 
 
If you change the Units value in the Advanced Options window, the 
dimensions in the Scan Size window change accordingly. 
 

Note:  The TeleRad PRO™, VXR-8™ and VXR-12 plus™ film 
digitizers have moveable film guides that detect film widths.  For 
an accurate scan width on these models, you must move the 
film guides so they are close to, but not touching, the sides of 
the film. 

 
 
 
Auto Size 
 
The Auto Size option is particularly helpful for scanning films of 
different sizes.  It enables the film digitizer to automatically detect the 
size of each piece of film.  If Auto Size is activated, the Width and 
Length boxes are grayed-out. 
 
� To have the film digitizer automatically determine film size:  Activate 

Auto Size. 
 

Note:  Auto Size is automatically activated when you click the 
Pre Scan button. 
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Multi-Film Mode 
 
You must activate Multi-Film Mode to scan films in batches.  Save To 
Disk is automatically activated when Multi-Film Mode is activated. 
 

 
 
� To scan films in batches:  Activate Multi-Film Mode. 
 

Note:  TWAIN 5.2 supports multi-film scans to disk only.  This 
means the images will not appear in the host application—they 
will be saved to the chosen location on the hard disk.  Third 
party medical imaging application vendors cannot support 
scanning multiple films to the screen (memory) with the VIDAR 
TWAIN interface.  For images to appear in the host application, 
the TWAIN interface must be in Single Film Mode (i.e., Multi-
Film Mode deactivated) and Save To Disk must be 
deactivated. 
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Save To Disk 
 
Activate Save To Disk to scan images and save them to a BMP (bitmap) 
or TIFF (tagged image file format) file in one operation.  The Save To 
Disk function adds a header to each file so an application knows how to 
open the file.  This can be useful if your imaging application does not 
support scanning to screen in a specific bit depth.  If you are scanning to 
screen and the software cannot process the image data you may get a) an 
error message, b) a black image or c) a poor quality image (image looks 
like television static). 
 
The VIDAR TWAIN interface supports scanning of 8-, 12- and 16-bit 
images to TIFF files.  Bit depth options depend on the digitizer being 
used. Support for BMP files is 8-bit only. If the Bitmap format is 
selected, the software will prompt you to select an appropriate file format 
for 12- or 16-bit scans. 
 
 

Note:  The File Format button may be grayed-out, but you will 
be prompted to select the file format in the File Naming window 
each time a batch scan is initiated. 

 
Note:  Save To Disk is activated and grayed-out when Multi-
Film Mode is activated. 

 
� To save images directly to disk:  Activate Save To Disk. 
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File Format 
 
� To select a file format before scanning: 
 

1. Click File Format in the Main window.  This opens the File 
Naming window: 

 

  
 
2. Open the File Format list and select a format.  Options are 

Bitmap (.bmp) and Tagged Image File Format (TIFF, .tif). 
 

Note:  This window will also appear after you click the Scan 
button if Scan To Disk is activated.  At that time, enter the 
image file path and file name(s).  Path and file format defaults to 
the last path and format used.  Image file names default to 
Untitled1, Untilted2, etc. 

TWAIN 4.2 user’s guide 
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3. Click OK to return to the Main window. 

 
You can only save an image directly to a file during scanning if the Save 
To Disk option is activated in the Main window.  When Save To Disk is 
activated, the File Naming window appears when you click Scan in the 
Main window.  Select the format, enter the file name, then click OK. 
 

Note:  The Bitmap file format does not support 12-bit or 16-bit 
grayscale images.  If the Bitmap format is selected, the 
software will prompt you to select an appropriate file format for 
12- or 16-bit scans. 

 
 
 
Advanced Options 
 
Advanced options control Main window setup and include film digitizer 
controls that are not in the Main window.  The “Advanced Options 
window” chapter, next in this manual, provides details. 
 
� To access the Advanced Options window:  In the Main window, click 

the Advanced button. 
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About 
 
The About window displays version and copyright information about the 
TWAIN software you are running. It also displays information about 
hard drive space and available memory on the host computer. 
 
� To view the VIDAR TWAIN version:  In the Main window, click the 

About button. 
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Digitizer Information 
 
The Digitizer Info button provides access to information about the 
digitizer.  Before calling for technical support, note this information and 
the film digitizer’s serial number.  This information helps the technical 
support representative address your questions. 
 
� To view digitizer information:  In the Main window, click Digitizer 

Info. 
 

  
 
Please note that most Vidar film digitizers report on the SCSI bus as 
“VXR-12” for backward compatibility purposes. 
 
The illustration above is an example.  Depending on the digitizer model 
that is installed, you may see different information than what is shown 
above. 
 
Pre Scan, Scan and Eject buttons 
 
The Pre Scan, Scan and Eject buttons are described in the “Scanning 
films” chapter, later in this manual. 
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Closing the TWAIN interface 
 
 
� To close the TWAIN interface without performing a scan:  In the 

Main window, click Exit.  After changes to the TWAIN controls are 
saved, control returns to the main (host) application (for example, 
PaintShop Pro). 

 
Note:  The Exit button is not available when a scan is in 
progress. 

 
 
� To cancel the current scan or prescan:  In the Main window, click 

Cancel.  Control returns to the main (host) application (for example, 
PaintShop Pro).  Changes to the TWAIN controls are not saved. 

 
Note:  If you are scanning a batch of films, clicking Cancel only 
cancels the film being scanned.  To cancel a large batch of 
films, remove all films from the feeder (this forces a TWAIN 
error). 
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Advanced Options window 

 
 
 
 
The Advanced Options window controls the setup of the Main window 
and provides options in addition to those in the Main window. 
 
� To access the Advanced Options window:  In the Main window, click 

the Advanced button. 
 
  

 
 
 

TWAIN 4.2 user’s guide 



 Advanced Options window 29 

TWAIN 4.2 user’s guide 

Note:  You can protect access to many TWAIN functions by 
setting up a password.  See “Password protection,” later in this 
chapter. 

 
 
 

Image Control 
 
 
Translation tables 
 
Standard configurations of the SIERRA™, SIERRA plus™, Diagnostic 
PRO™ and Diagnostic PRO plus™ allow for one default translation 
table.  This table, called Logarithmic, will be the only option in the 
Translation Table list.  While this may appear to be a loss of 
functionality, limiting the choice to a single translation table minimizes 
the risk of poor image quality due to improper table selection. 
 
If you have a VXR-8™, VXR-12™, VXR-12 plus™, VXR-16™, VXR-
16 Dosimetry PRO™ or TeleRad PRO™ film digitizer, the Translation 
Table list allows you to select one of eight translation tables defined in 
the film digitizer.  The tables are: 
� LinearHI 
� Logarithmic 
� LinearOD 
� SQROOT 
� POWER07 
� POWER05 
� POWER03 
� POWER10. 
 
The tables are used to convert, or map, data from the film digitizer into a 
range better suited to your requirements.  They are used, for example, to 
map data from one set of grayscale values to another. 
 
The names of the default translation tables in the film digitizer reflect the 
mathematical functions they perform on grayscale data.  On the next two 
pages are brief explanations of the default translation tables built into the 
film digitizer. 
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Translation table notes: 
� Dark Enhance is not available on all models. 
� 16-bit functions are similar to the calculations below. 

 
 

Linear Optical Density (OD) Translation Table 

12-bit depth 
� Maps grayscale 0 to 0 and grayscale 4095 

to (1000) * (maximum OD value) with a log 
function for the values between.  Subtract 
the result from (1000) * (maximum OD 
value).  This grayscale value is about 1000 
times the OD value for that pixel.  There 
should be no grayscale values above 1000 
times the maximum OD value for the film 
digitizer. 

� Results in an image similar to the result of 
inverting the Logarithmic Translation Table. 

� Activates Dark Enhance automatically. 
 

8-bit depth 
� Starts with the 12-bit depth table and maps 

grayscale 0 to 0 and grayscale (1000) * 
(maximum OD value) to 255.  The resulting 
grayscale value multiplied by 3.0 and 
divided by 256 is about equal to the OD 
value for that pixel. 

� Results in an image similar to the result of 
inverting the Logarithmic Translation Table. 

� Activates Dark Enhance automatically. 

Logarithmic Translation Table 

12-bit depth 
� Maps grayscale 0 to 0 and 4095 to 4095 

with a log function for the values between. 
� Results in the lightest images of the default 

translation tables. 
� Activates Dark Enhance automatically. 

8-bit depth 
� Maps grayscale 0 to 0 and 4095 to 255 

(equivalent to discarding the least significant 
4 bits from the 12-bit table) with a log 
function for the values between. 

� Results in the lightest images of the default 
translation tables. 

� Activates Dark Enhance automatically. 
 

Linear Histogram-Independent (HI) Translation Table 

12-bit depth 
� Outputs the same grayscale value that was 

input to the translation table. 
� Results in the darkest images of the default 

translation tables if you deactivate the Dark 
Enhance option. 

8-bit depth 
� Maps 12-bit values 0-15 to 8-bit value 0, 16-

31 to 1, etc.  (equivalent to discarding the 
least significant 4 bits from the 12-bit table). 

� Results in the darkest images of the default 
translation tables if you deactivate the Dark 
Enhance option. 
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Power-Based Translation Table 

12-bit depth 
� Outputs from 0 to 4095 are derived from 

curves that are linear approximations of the 
root function Y = Xi, where i = 0.1, ...  , 1.0 
and X is the calculated value at each OD 
step (not the direct data from the array). 

� You can generate power functions by 
selecting a different power level between 1 
and 10.  1 results in the lightest image, 
while 10 results in the darkest image.  Use 
1 for dark films and 10 for light films. 

� Activates Dark Enhance automatically. 
 

8-bit depth 
� Generated by discarding the least significant 

4 bits from the 12-bit table. 

Square Root Translation Table 

12-bit depth 
� Maps grayscale 0 to 0 and 4095 to 4095, 

with a square root function for the values 
between. 

� Results in a lighter image than the Linear 
OD Translation Table, but darker than the 
Logarithmic Translation Table. 

� Activates Dark Enhance automatically. 

8-bit depth 
� Maps grayscale 0 to 0 and 4095 to 255 

(equivalent to discarding the least significant 
4 bits from the 12-bit table), with a square 
root function for the values between. 

� Results in a lighter image than the Linear 
OD Translation Table, but darker than the 
Logarithmic Translation Table. 

� Activates Dark Enhance automatically. 
 
 
 



32 Advanced Options window 

TWAIN 4.2 user’s guide 

Dark Enhance 
 
Dark Enhance is not available for newer VIDAR film digitizers, since it 
is not required for optimum image quality.  This feature will be activated 
by default when an older product, such as a TeleRad PRO™, VXR-8™ 
or VXR-12 plus™, is in use. 
 
Dark Enhance lightens the image or increases the contrast in the dark 
areas of the image. 
 

Note:  Some of the built-in translation tables automatically 
activate Dark Enhance.  If you select one of these tables, you 
cannot deactivate Dark Enhance. 

 
 
� To use dark enhancement:  Activate Dark Enhance. 
 
 
 
Exposure 
 
Most newer VIDAR film digitizers (SIERRA™, SIERRA plus™, 
Diagnostic PRO™ and Diagnostic PRO plus™) are configured with a 
default exposure time for the best image quality.  If you have one of 
these products, the Exposure feature will be grayed out.  This feature is 
available when an older product, such as a TeleRad PRO™, VXR-8™ or 
VXR-12 plus™, is in use. 
 
Exposure is the amount of time light strikes the CCD array for each scan 
line.  The longer the exposure, the lighter the scan; the shorter the 
exposure, the darker the scan.  The exposure setting changes the scan 
speed:  the shorter the exposure time, the faster the scan. 
 
� To set exposure time:  Enter a value in milliseconds in the Exposure 

box. 
 

Note:  The exposure range is 10 to 40 milliseconds in  
1 millisecond increments for VXR-12s with serial numbers 
greater than 22999.  Exposure time for VXR-12s before serial 
number 23000 is 10 to 20 ms. 
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Note:  If the exposure is too high, detail will be lost in light areas 
of the film. 

 
Note:  Each time you change the Exposure value, a dark 
normalization is initiated when you exit the Advanced Options 
window. 

 
 
 
Line Averaging 
 
Line Averaging is not available for newer VIDAR film digitizers, since it 
is not required for optimum image quality.  This feature is available 
when an older product, such as a TeleRad PRO™, VXR-8™ or VXR-12 
plus™, is in use. 
 
Line averaging increases the signal-to-noise ratio, which improves 
grayscale accuracy, thereby improving image clarity.  It is implemented 
in the Y-axis by averaging together 2 or 4 lines during the scan.  Higher 
line averaging improves grayscale accuracy in the scans of the grayscale 
step wedge by a smaller standard deviation for the dark steps. 
 
� To use line averaging:  Activate Line Average and select the 

Number of lines (2 or 4). 
 
If Line Averaging is grayed-out, the digitizer model you are using does 
not support this function. 
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Scanner Controls section 
 
 
 
Password Protection 
 
Password protection controls access to some of the TWAIN settings, 
such as: 
� Resolution and unit of measure 
� Depth 
� Translation tables 
� Pre scan 
� ROI selection controls 
� Line averaging 
� Dark enhance 
� Exposure 
� Save to disk 
 
 
� To establish a password: 
 

1. Activate Password Protection.  This opens the Password 
window.  You are prompted to enter a password. 

 
2. If this is the first time a password is being set up:  Do not enter 

anything in the Password window.  Click OK to return to the 
Advanced Options window.  (By default there is no password.) 

  or 
 If a password was previously set up:  Enter the password in the 

Password window, then click OK. 
 
3. Click GUI Control.  This opens the Custom User Interface 

window. 
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4. In the Custom User Interface window, click Change Password.  
This opens the Change Password window: 

 

  
 
5. In the Change Password window, enter the new password, then 

confirm the new password.  (A password can be any combination 
of characters.)  Finally, click OK to close the Change Password 
window. 

 
 
� To disable password protection:  In the Advanced Options window, 

click Password Protection again, then click OK in the Password 
window. 

 
 When password protection is deactivated, the software still 

remembers your last password. 
 

Note:  If your password is lost, you must reload the TWAIN 
software. 
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Auto Eject 
 
The Auto Eject option controls what happens to films that have been 
scanned. 
 
� To eject each film into the exit tray after each scan:  Activate Auto 

Eject.  The film digitizer will be ready to accept another film when a 
scan is complete.  Auto ejection is useful when you are scanning 
many films consecutively. 

 
� To retain the film in the digitizer after each scan:  Deactivate Auto 

Eject.  The film will stop moving when the scan is complete or at the 
end of the film (whichever comes first).  This is useful when you want 
to perform multiple scans on one film.  When you click the Scan 
button, the digitizer automatically backs up and stages the film in 
preparation for another scan.  However, when you load a new film, 
the previously scanned film will be automatically ejected. 

 
Note:  Auto Eject does not affect prescanning.  After a 
prescan, the film is restaged rather than ejected. 

 
 
 
Bilevel Scanning 

 
Note:  TWAIN 5.2 does not support Bilevel Scanning with any 
VIDAR product. 
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Units 
 
The Units list controls the unit of measure for the Scan Size list and the 
dimension boxes in the Main window.  If you change the unit of measure 
in the Units list, the Scan Size window changes accordingly. 
 
When you select a different unit of measure, the software automatically 
selects the closest scan size in the new units.  For example, if the scan 
size is 14 by 17 inches and you change the value in the Units list to 
centimeters, the new scan size is 35.6 by 43.2 cm.  For pixels, the 
software multiplies the dimensions in inches by the resolution in dots per 
inch (dpi) to obtain the value in pixels. 
 
� To select a unit of measure:  Open the Units list and click Inches, 

Centimeters or Pixels. 
 
 
 

Image Shift 
 
Image shift converts 12-bit data to16-bit data before the data is 
transferred to the host application.  This allows you to perform a 12-bit 
scan to screen, rather than saving the image to disk, if your host 
application supports 16-bit data. 
 

 
 

Note:  Only activate the 12 HI option if the host application 
supports 16-bit data.   

 
Note:  When Depth is set to 8-bit in the Main window, the 12 HI 
option in the Image Shift section will not be visible. 

 
 
� To use image shift:  Activate 12 HI by clicking on the checkbox. 
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Maximum Image Size 
 
The Max Image Size options in the Advanced Options window allow 
you to specify the maximum film size as up to 14 inches x 17 inches or 
up to 14 inches x 51 inches.  Unless you are scanning long films, set the 
maximum film size to 14 inches x 17 inches. 
 
When digitizing films longer than 17 inches, you must support the film 
above the feed tray and lift the film over the bottom lip on the exit tray so 
that the film can pass easily through the film digitizer. 
 

 
 
� To set the maximum image size:  Select the option appropriate for 

your scanning needs. 
 

Note:  The maximum film length that can be scanned with 
TWAIN is 51 inches. 

 
Note:  When scanning perforated films, you may need to 
manually set the size instead of using Auto Size.  The scanner 
may see the perforations as a film end. 
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GUI Control button 
 
GUI (graphic user interface) Control is used to manage which functions 
are available in the Main window and the Advanced Options window.  
This allows the TWAIN interface to be configured to limit the controls 
an operator can change. 
 
� To configure the interface: 
 

1. In the Advanced Options window, click GUI Control.  This 
opens the Custom User Interface window: 

 

  
 

Note:  If Password Protection is deactivated in the Advanced 
Options window, GUI Control is not available (the button is 
grayed out). 

 
2. Use the check boxes in this window to enable or disable the 

desired functions in the Main window. 
 

Note:  Features not supported by the scanner in use will be 
grayed-out and unavailable. 
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Calibrate button 
 
Calibrate directs the film digitizer to calibrate white and black levels.  
Calibration compensates for pixel-to-pixel variations in both the white 
and black ends of the grayscale to produce an even, consistent scan.  
Calibration is also automatically performed when the film digitizer is 
turned on.  VIDAR provides recommendations for calibration, which 
depend on the firmware version in the digitizer.  Check with Medtech to 
determine your firmware version and calibration requirements.  In most 
cases, the firmware can be updated in the field at no cost. 
 
� To begin calibration:  Click Calibrate.  When calibration is finished, 

a success message appears. 
 

Note:  If you are using a TeleRad PRO™, VXR-8™ or VXR-12 
plus™, recalibrate after adjusting shutter width to optimize light 
levels for best image quality.  To recalibrate, the shutters must 
be opened the full width. 

 
If black vertical bands appear on the very outside of one or both sides of 
images scanned with a TeleRad PRO™, VXR-8 plus™, or VXR-12 
plus™, either the unit was not calibrated with the film guides all the way 
open after scanning a small film then going to a larger film, OR one or 
both shutters may have become detached from the film guides on the 
film feeder.  To check the film guides: 
 
1. Turn off and unplug the digitizer. 
2. Unscrew the two thumbscrews on the back of the film feeder, then 

remove the film feeder. 
3. In the throat of the digitizer, slide the two black tabs as far as they will 

go toward the outside. 
4. Reinstall the film feeder with shutters and film guides open all the 

way. 
5. Plug in and turn on the digitizer.  (It will recalibrate the full array now 

that the shutters are fully open.) 
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Digitizer Info button 
 
The Digitizer Info button provides access to information about the 
digitizer.  Before calling for technical support, note this information and 
the film digitizer’s serial number.  This information helps the technical 
support representative address your questions. 
 
� To view digitizer information:  In the Advanced Options window, 

click Digitizer Info. 
 
  
 
 
 

OK button 
 
� To accept changes and close the Advanced Options window:  Click 

OK.  Control returns to the Main window. 
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Scanning films 

 
 
 
 

Overview 
 
Here are the major steps required to scan one or more films (with 
references to sections later in this chapter): 
 
1. Load film or film stack into digitizer’s feed tray. 
 
 See “Loading films,” which covers loading both single films and 

multiple films. 
 
2. (Optional)  Prescan film, then (optional) define a region of interest 

(ROI). 
 
 See “Prescanning and defining a region of interest (ROI).” 
 
3. Scan film or stack of films. 
 
 See “Scanning,” which covers scanning single films and multi-film 

stacks. 
 
4. (If film is not automatically ejected...)  Manually eject film. 
 
 See “Ejecting a film.” 
 
5. Accept or discard image. 
 
 See “Finishing up.” 
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Loading films 
 
 
Loading a single film — Scan to Screen Mode 
 
Use the following procedure to load a single film in Scan to Screen 
mode. 
 

Note:  Films longer than 17 inches must be scanned in the 
single film mode.  Even though the long film option is always 
available, not all digitizers support this function. 

 
1. Hold the film in front of you as you would view it on a light box. 
 
2. Flip the film toward you so that the top 

and bottom edges of the film are 
reversed.  (The film is upside down.) 

 
3. If the digitizer is capable of multi-film 

scanning, you can load a single film 
into the throat of the scanner or in front 
of the blue lip.  If a film is not sensed in 
the throat, the software prompts the 
digitizer to load film from the blue lip.  
(However, not all scanning applications 
can look in multiple locations for film.) 

 
 If the digitizer handles only single ilms, 

load the film into the throat of the igitizer. 
 
 When scanning a tall film, make s

film support is fully extended if th
digitizer is equipped with this feat

 

 f
d
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4. Position the film within the guides: 
 
� VXR-8 plus™, VXR-12 plus™ or TeleRad PRO™:  Center the 

film between the film guides.  Adjust the film guides so that they 
are close to, but not touching, the edges of the film.  Use the rulers 
on the input tray to help adjust the film guides. 

 
� Diagnostic PRO™, Diagnostic PRO plus™, SIERRA™ and 

SIERRA plus™, DiagnosticPRO Advantage and DosimetryPRO 
Advantage models:  Place the film against the left film guide. 

 
� CadPRO Advantage: Place 8” by 10” films into the film feeder 

horizontally (landscape orientation). Place 10” by 12” films in to the 
film feeder vertically (portrait orientation). 
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Loading single or multiple films (Multi-Film Mode or 
Save To Disk Mode) 
 
Use the following procedure to load one or more films in either Multi-
Film Mode or Save To Disk Mode (single films or batch scans). 
 

Note:  It is possible to select and scan one film at a time when 
scanning in Multi-Film Mode. 

 
Note:  Films longer than 17 inches must be scanned in single 
film mode. 

 
1. Hold the film stack in front of you as you would view it on a light 

box.  The first film to be scanned should be at the back of the stack. 
 
� VXR-8 plus™, VXR-12 plus™ and TeleRad PRO™ film 

digitizers could have been ordered with an optional 10-sheet feed 
tray.  When the digitizer is equipped with this feed tray, films 
scanned in batch mode can be of multiple lengths, but must be the 
same width. 

� Diagnostic PRO plus™, Mammography PRO™, Dosimetry 
PRO™, Dosimetry PRO Advantage, Diagnostic PRO Advantage 
and VXR-16™ film digitizers have standard 25-sheet feed trays 
that handle mixed film sizes. 
 
The CadPRO Advantage is available with either a 50-sheet film 
feeder or a 100-sheet film feeder. 

 
� SIERRA™ and SIERRA plus™ units with serial numbers in the 

range 140000 to 140799 could have been ordered with optional  
6-sheet film feeders. 

 
� SIERRA plus™ film digitizers with serial numbers 140800 and 

above can be ordered with optional 10-sheet film feeders. 
 
2. Place the film stack in the feed tray (top of the film digitizer) with the 

edge of the stack resting in front of the lip (blue edge).  Be sure the 
film support is fully extended when scanning tall films. 
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3. Position the films within the guides: 
� VXR-8 plus™, VXR-12 plus™ or TeleRad PRO™:  Center the 

films between the film guides.  Adjust the film guides so that they 
are close to, but not touching, the edges of the films.  Use the 
rulers on the input tray to help adjust the film guides. 

� Diagnostic PRO™, Diagnostic PRO plus™, SIERRA™ and 
SIERRA plus™:  Place the films against the left film guide. 

 
� CadPRO Advantage: Place 8” by 10” films into the film feeder  

horizontally (landscape orientation). Place 10” by 12” films in to the 
film feeder vertically (portrait orientation). 
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Prescanning and defining a region of interest (ROI) 
 
Prescanning digitizes the entire film at the lowest resolution and displays 
the image in the Preview area of the Main window.  A prescan makes it 
easier to define a region of interest (ROI).  A film automatically restages 
after a prescan in preparation for a scan.  Pre Scan automatically sizes 
the original film and allows you to use the image preview to define the 
region of interest. 
 

Note:  SIERRA™ and SIERRA plus™ units with serial numbers 
140799 and below do not support prescanning. 

 
 
� To perform a prescan: 
 

1. Load the film into the film digitizer (as described in “Loading 
films,” earlier in this chapter). 

 
2. In the VIDAR TWAIN interface Main window, click Pre Scan. 
 
z To cancel the prescan before it is complete:  Click Cancel. 

 
 The film moves through the film digitizer.  After the preview scan 

is completed, a thumbnail of the image appears in the Preview 
area of the Main window and the progress bar under the Preview 
area displays the number of kilobytes scanned (see example on 
next page).  The film will move back up into the ready position. 

 

Note:  If a prescan is attempted while in Multi-Film Mode, the 
following message will appear and Multi-Film Mode will 
automatically be deactivated in preparation for a prescan. 
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3. Adjust the ROI to the area you want to scan:  right-drag the mouse 

over the desired area. 
 
 As you drag, the coordinates of the ROI are displayed to the right 

of the Preview area. 
 

 

Region of interest

 
 
z To redraw the ROI:  Reposition the mouse and drag again. 

 
You are now ready to scan the ROI: when you click the Scan button (as 
described in “Scanning,” the next section in this chapter), only the region 
of interest will be scanned using the selected scanning parameters. 
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Scanning 
 
 
Scanning single films 
 
After loading the film and specifying scanning parameters, you are ready 
to scan.  The Scan command directs the film digitizer to scan the film 
loaded in the film digitizer. 
 
� To initiate a scan:  In the VIDAR TWAIN interface Main window, 

click Scan. 
 
 The film is staged before scanning takes place.  This means that the 

film will be fed down about 1.5" into the digitizer, then come back up 
about 0.5". 

 
 During the scan, the progress bar under the Preview area displays the 

number of kilobytes scanned. 
 

Note:  If no film is loaded when you click Scan, a message box 
appears to tell you no film is loaded.  Click OK, then load a film.  
You must click the Scan button again to scan. 

 
� To stop a scan before it is completed:  Click Cancel. 
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Scanning films (Multi-Film Mode and Scan To Disk 
Mode) 
 
Scan To Disk Mode enables scanning directly to a TIFF or BMP file 
format.  TIFF images may be saved in 8-bit, 12-bit or 16-bit depth, 
depending on the capabilities of the digitizer attached.  The BMP file 
format only supports 8-bit depth.  It is not possible to scan in Multi-Film 
Mode unless Save To Disk is activated. 
 

Note:  This TWAIN interface does not support scanning multiple 
images to screen.  

 
 
1. In the VIDAR TWAIN interface Main window, select the number of 

films to be scanned. 
 

Note:  An error will occur if the number of successfully scanned 
films does not equal the number requested. 

 
2. Click the Scan button. 
 
3. Select the File Format at the top of the window. 
 
4. Select the disk location for the saved files in the Images Save Path 

box.  Enter the path or click Browse to find the desired path. 
 
5. The lower portion of the window provides boxes for naming each 

image, corresponding to the number of films selected.  Enter a file 
name for the first image in the first box provided. 

 
6. Click in the next box.  Name the rest of the files using one of these 

methods: 
 
� Click the Auto Number button to replicate the first filename and 

append a number (e.g., Film2, Film3, etc.) to the remaining films. 
  or 
� Enter a new path and file name for each of the remaining films. 

 
7. After naming all the files, click OK to start the batch scan. 
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z To stop the batch scan before it is complete:  Click Cancel for 
each film, or remove films to force an error. 

 
8. After the batch completes, the Main window appears. 
 
 
 

Ejecting a film 
 
Ejecting causes the feed rollers in the film digitizer to turn until the film 
is free of the rollers and drops into the exit tray. 
 

CAUTION:  If a film is held in the film digitizer by the feed 
rollers, pulling it down and out slowly will not harm the digitizer, 
but may scratch the film; however, it’s best to use the TWAIN 
interface to eject the film, as described below. 

 
 

Note: 
� If Auto Eject is activated in the Advanced Options window, 

films are ejected automatically. 
� In Multi-Film Mode, films are ejected automatically. 

 
 
If a film is not automatically ejected (Auto Eject is deactivated in the 
Advanced Options window), then after the scan is complete: 
 
� To eject the film from the feed path:  Click Eject. 
 
� To scan the film again:  Leave the film in the feed path and click 

Scan.  The digitizer will automatically reset the film and scan it. 
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Finishing up 
 
After the film digitizer captures the image, the image will either appear 
in the host software application, or the image will be saved to the 
specified location (Multi-Film Mode and Save To Disk Mode).  If the 
image was saved to disk, it will not appear in the host application; you 
will need to open the file to view the image. 
 

Note:  If you defined an ROI, the ROI image will appear in a 
separate window behind the TWAIN window, unless Save To 
Disk is activated in the Advanced Options window. 

 
 
� To close the TWAIN interface:  Click Exit. 
 
 
 

Using the image application 
 
For details on zooming, panning and other image controls, refer to the 
manual for the host application. 
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Appendix:  
Improving image quality 

 
 
 
 

Calibrating your monitor 
 
Good image quality depends on proper monitor output.  When your 
monitor accurately displays an image, you can effectively evaluate image 
quality and successfully optimize the image.  Without an accurate image, 
you may not be able to obtain good quality.  Here is one easy method for 
calibrating a monitor: 
 
1. Open an SMPTE pattern image (you can open an SMPTE pattern—

shown on the next page— in your Web browser by clicking 
www.dclunie.com/images/smpte.512.512.8.gif). 

 
2. Minimize the monitor’s contrast and brightness controls. 
 
3. Increase the brightness until you just see the bars in the corners. 
 
4. Increase the contrast to about 80% or greater until you can see the 

0%/5% and 95%/100% squares on the image as clearly as possible. 
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0%/5% square 95%/100% square 
 

Note:  If you are viewing an electronic copy of this document on 
a monitor and you can’t see either the 0%/5% square or the 
95%/100% square on this page (indicated by the arrows), your 
monitor needs to be calibrated. 
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Optimizing image quality in image processing 
applications 

 
This section describes quick adjustments you can make to images to 
compensate for the lack of a display look-up table in non-clinical image 
processing applications, such as PaintShop Pro and Photoshop.  The 
applications covered here—PaintShop Pro 7 and Photoshop 6—have 
been extensively tested as host applications for the Vidar TWAIN 
interface, and are only recommended as a means for checking film 
digitizer operation, not as a substitute for a high quality medical 
imaging/PACS system. 
 
 
 
Corel PaintShop Pro™ 
 
 
Adjusting image gamma 
 
Use the Gamma Correction command to adjust the brightness and 
contrast of an image in unison.  On a computer monitor, a small 
difference in brightness at a low brightness level is not equal to the same 
variation at a high level.  Gamma correction compensates for this. 
 
� To adjust gamma: 
 

1. Colors > Adjust > Gamma Correction. 
  or 
 Press SHIFT-G. 
  or 
 Click the Gamma Correction button in the toolbar. 
 
 This opens the Gamma Correction window (see next page): 
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Original image Modified image 
 

  
 
2. By default, the Red, Green and Blue slider bars in the Gamma 

Correction window are linked so they move in unison.  The graph 
to the right of the sliders represents the shadows and highlights of 
the image.  Click and drag any slider (or type a number into any 
box) to move the curve in the graph.  Dragging to the right pushes 
more pixels into a higher lightness value, which lightens the image.  
Dragging to the left darkens the image. 

 
3. Click OK to close the dialog box and apply the settings. 

 
Because gamma correction can leave an image looking somewhat “flat,” 
you may need to increase contrast after correcting gamma. 
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Adjusting brightness and contrast 
 
The Brightness command lightens or darkens the entire image or 
selection.  The Contrast command changes the amount of shading 
between areas.  You can use it to sharpen an image and make specific 
areas stand out. 
 
� To adjust brightness and/or contrast: 
 

1. Colors > Adjust > Brightness/Contrast. 
  or 
 Press SHIFT-B. 
  or 
 Click the optional Adjust Brightness/Contrast button in the 

toolbar. 
 
 This opens the Brightness/Contrast window: 
 

Original image Modified image 
 

  
 

TWAIN 4.2 user’s guide 



58 Appendix:  Improving image quality 

TWAIN 4.2 user’s guide 

2. In the Brightness/Contrast window: 
 
� To update the original image as you change the settings:  

Activate Auto Proof. 
 
� To brighten the image:  Move the Brightness slider to the right, 

or type a positive number in the box. 
 
� To darken the image:  Move the Brightness slider to the left, or 

type a negative number in the box. 
 
 (The brightness value is added to or subtracted from the 

brightness values of all the pixels.) 
 
� To increase the contrast:  Move the Contrast slider to the right, 

or type a positive number in the box. 
 
� To decrease the contrast:  Move the Contrast slider to the left, 

or type a negative number in the box. 
 
3. Click OK to close the window and apply the settings. 

 
 
 
Equalizing 
 
Equalizing distributes the grayscale values of pixels more evenly across 
the range from black to white.  It makes the darkest pixel as close to 
black and the lightest pixel as close to white as possible.  It then 
distributes the remaining pixels evenly between these two values.  This 
produces an averaging, or tempering, of image brightness. 
 
� To equalize an image: 
 
 Colors > Histogram Functions > Equalize. 
  or 
 Press SHIFT-E. 
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Stretching 
 
If the grayscale values of an image don’t extend across the entire range 
from black to white, the image lacks contrast.  Stretching distributes the 
highest and lowest grayscale values closer to the extremes so they cover 
more of the range. 
 
� To stretch the grayscale values: 
 
 Colors > Histogram Functions > Stretch. 
  or 
 Press SHIFT-T. 
 
 
 
Adobe Photoshop™ 
 
 
Adjusting black and white points 
 
The Auto Levels feature and Auto button in the Levels window 
automatically define the lightest and darkest pixels in each channel as 
white and black, then redistribute the intermediate pixel values 
proportionally.  This feature gives good results when an image with an 
average distribution of pixel values needs a simple contrast adjustment. 
 
� To set black and white points automatically: 
 
 Image > Adjust > Auto Levels. 
  or 
 Image > Adjust > Levels (this opens the Levels window, shown on 

the next page), then click Auto. 
 
In the Levels window, you can also enter values directly in the Input 
Levels and Output Levels boxes.  Entering values into the Output 
Levels box decreases the contrast in highlight areas, darkening the 
image. 
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Equalizing 
 
The equalizing function redistributes an image’s grayscale values to 
more evenly represent the entire grayscale range.  With this function, 
Photoshop finds the brightest and darkest values in the image and 
attempts to equalize the brightness—that is, to distribute the intermediate 
grayscale values evenly throughout the range between black and white. 
 
� To equalize an image:  Image > Adjust > Equalize. 
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Adjusting contrast 
 
The Auto Contrast function is used to automatically adjust contrast or 
highlights and shadows.  Adjusting contrast maps the darkest and lightest 
pixels in the image to black and white.  The Auto Contrast function clips 
the white and black pixels by 0.5%—that is, it ignores the first 0.5% of 
either extreme when identifying the lightest and darkest pixels in the 
image.  This clipping of grayscale values ensures that white and black 
values are representative areas of the image’s content, rather than 
extreme pixel values. 
 
� To adjust contrast automatically:  Image > Adjust > Auto Contrast. 
 
 
 
Adjusting tonal values with the Curves feature 
 
The Curves feature lets you make precise adjustments to one area of the 
tonal range while minimizing the effects on the others. 
 
1. Image > Adjust > Curves.  This opens the Curves window: 
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2. Click the part of the curve you want to adjust.  Drag until the image 
looks as you want. 

  or 
 Click to fix a point on the curve.  Click and drag to adjust. 
  or 
 Enter an Input and Output value for the selected point on the curve. 
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	Using the image application

